
CExploring the World 
of 3D

You already know that in the arena of computer graph-
ics, there are two playing fi elds: pixel-based graphics and 
vector-based graphics. It just so happens that in the world 
of 3D, there is also an important distinction between 
pixels and vectors. When you think about 3D, imagery 
like that seen in blockbuster Hollywood movies and in 
animated feature fi lms comes immediately to mind. The 
tools used to create these realistic images are incredibly 
sophisticated (and expensive), and they render shading, 
surface textures, and refl ections using pixels. In contrast, 
the 3D feature in Illustrator uses vector artwork to gen-
erate not just the 3D geometry of an object but also the 
lighting and shading.

This distinction is important, because you will fi nd that in no way does 
Illustrator replace applications like Autodesk 3ds Max or Maya. In fact, as 
you’ll soon learn, the 3D feature in Illustrator has its share of limitations. At 
the same time, the vector-based 3D functionality in Illustrator is extremely 
powerful—and useful—once you learn its strengths.

At fi rst blush, you can think about how 3D in Illustrator can assist with prod-
uct packaging mock-ups and help give a logo that added touch. But the real 
power of 3D is how it can be applied to everyday creative tasks. Throughout 
this chapter, the creative side of 3D will become readily apparent.
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3D in Illustrator: What It Is 

and What It Isn’t
Few features in Illustrator are as fun to use as the 3D effect. You might want 
to clear your calendar for a few days so you have time to explore all the cool 
functionality you’re about to discover.

However, before you tie a bungee cord to your ankles and jump into the 
spectacular world of 3D, it’s important to realize just what the 3D effect in 
Illustrator is capable of and what its limitations are. In this way, you’ll get a 
better idea of what you can realistically expect from the 3D effect:

• The 3D effect in Illustrator is real 3D. Unlike 3D plug-ins or other vec-
tor-based applications that have 3D features (such as FreeHand or Core-
lDRAW), the 3D effect in Illustrator isn’t some cheesy feature. Rather, 
Illustrator does real 3D rendering in a true 3D environment. Although 
the artwork that appears on the artboard is 2D, within the Effect dialog 
box the artwork exists in a 3D space where you can rotate and view it 
from any angle (Figure C.1).

 

Figure C.1 Once you’ve 

applied a 3D effect to a 

shape, you can choose to 

view it from any angle.
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• The 3D effect in Illustrator is vector-based. Illustrator applies 3D 
effects to vector objects, and the result is a vector object. Lighting and 
shading take place through the use of blends (more detail on this later). 
Illustrator does not use ray tracing—a pixel-based rendering technique 
that can create shading and lighting with refl ections and refractions.

• The 3D effect in Illustrator supports artwork mapping. The 3D effect 
has the ability to map 2D artwork onto the surface of 3D objects. Art-
work that will be mapped onto a 3D surface must fi rst be defi ned as an 
Illustrator symbol.

• The 3D effect in Illustrator is self-contained. Because 3D in Illustrator 
is an effect, it applies to particular objects you have selected. Each object 
is treated as a separate entity and lives in its own individual 3D world. 
This means separate 3D objects cannot interact with or intersect each 
other (like a rod that pierces a sphere). Additionally, each object main-
tains its own vanishing point. This limitation makes it diffi cult to create 
3D compositions in which multiple objects share the same vanishing 
point (although using groups can make a difference).

• The 3D effect in Illustrator is proprietary. The 3D effect is an internal 
feature and is applicable only within Illustrator. You cannot export 3D 
geometry from Illustrator (although you can export the 2D representa-
tion of that artwork), and you cannot import 3D geometry from CAD or 
3D modeling applications (such as Maya or even Google SketchUp). This 
also means the 3D support in Photoshop Extended doesn’t work with 3D 
art made from Illustrator.

• The 3D effect in Illustrator is a live effect. As a live effect, the 3D fea-
tures in Illustrator abide by the same rules as other effects. This means 
you can apply 3D effects to groups (which is important, as you’ll see 
later), you can save them as graphic styles, you can edit them easily, and 
you can expand them.

Many different uses come to mind when we think about using the 3D effect 
in Illustrator. Drawing boxes and bottles for product packaging concepts and 
mock-ups, as well as text headlines or logos with added dimension, are some 
examples. However, as you will see, the 3D effect in Illustrator can also serve 
in an extremely creative fashion. As you explore the different capabilities of 
the 3D effects, try to envision how you might use them to create illustrations 
or design elements. We will help by offering examples along the way, provid-
ing a spark for your creativity.

NOTE Because 

Illustrator does real 

3D rendering, performance is 

commensurate with system 

resources.
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Looking Inside the 3D Effect
The 3D feature in Illustrator is extremely deep and comprises four compo-
nents, each serving a different purpose:

• Extrude & Bevel. The extrude effect adds dimension to an object by 
extending it and giving it depth. Although 2D objects have an X axis 
and a Y axis, an extruded object also adds a Z axis. A simple example is 
a square with just one side (front) that becomes a cube (Figure C.2) with 
six sides (front, back, top, bottom, left, and right). A bevel is a chiseled 
effect you can add to the surface of an extruded object (Figure C.3).

 

 

• Revolve. The Revolve effect adds dimension to an object by defi ning an 
axis and then revolving the shape around that axis. A simple example is 
a rectangle with just one side (front) that becomes a cylinder (Figure C.4) 
with three surfaces (side, top, and bottom).

 

Figure C.2 When you start 

with a regular square (left), 

adding an Extrude effect 

results in a six-sided cube 

(right).

Figure C.3 Bevels can 

add a chiseled appearance 

to an extruded object.

Figure C.4 When you start 

with a regular rectangle 

(left), adding a Revolve effect 

results in a three-sided cylin-

der (right).
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• Rotate. The Rotate effect doesn’t add dimension at all but simply allows 
you to rotate your object in 3D space (basically an extrude without the 
depth added). This allows you to apply perspective to an object using a 
3D reference (Figure C.5).

Figure C.5 When you start 

with a regular square (left), 

adding a Rotate effect results 

in a shape that appears to 

have the perspective of 3D 

(right).

• Artwork mapping. Artwork mapping is a feature used to render 2D art-
work onto the surface of a 3D object (Figure C.6).

Figure C.6 Once 

you’ve created regular 

artwork (left), you can 

map it onto the surface 

of a 3D object (right).

Naturally, each of these four components is a full-blown feature and 
requires its own detailed instructions. However, before we get to that, 
you need to learn some general information about how the 3D effect in 
Illustrator works.

Using Fills and Strokes and the 3D Effect

To harness the depth of the 3D effect in Illustrator, you have to learn what 
makes the effect tick. The way in which you create and edit your vector 
shape affects how the 3D settings are applied to that shape. For example, 
take two identical shapes: One has a stroke applied, and the second has the 

NOTE Illustrator allows 

artwork mapping only 

on objects with the 3D Extrude 

& Bevel or 3D Revolve effect 

applied. The 3D Rotate effect 

does not support artwork 

mapping.



APPENDIX C: EXPLORING THE WORLD OF 3D6

stroke set to None (Figure C.7). When the same 3D Extrude effect is applied 
to both objects, each assumes a different appearance (Figure C.8).

Here’s what happens: Right before Illustrator applies 3D to an object, the 
effect breaks apart the elements internally and applies the 3D effect to each 
of the elements. When you have an object that has just a fi ll applied, the fi ll 
itself is extruded, and the extruded areas are shaded in the same color as the 
fi ll. However, if a stroke is applied to the object as well, Illustrator extrudes 
the fi ll and the stroke, and the appearance of the extruded areas shows the 
stroke color, not the fi ll color.

In fact, when you have a stroke applied, Illustrator is really extruding two sep-
arate objects—the fi ll and the stroke around it (Figure C.9). If you change the 
Fill setting to None, you’ll be able to see right through the middle of the object, 
because then Illustrator is extruding only a stroke, not a fi ll (Figure C.10).

Figure C.7 These shapes 

are identical with the excep-

tion of the 1-point stroke 

applied to the one on the left.

Figure C.8 The extruded 

area of the shape on the left 

takes on the appearance of 

the object’s stroke, whereas 

the shape on the right uses 

the appearance of the fi ll.

Figure C.9 When an object 

with a fi ll and a stroke is 

extruded, you  can think of 

the stroke as a slipcase for 

the fi ll.
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Figure C.10 When no fi ll is 

present, Illustrator extrudes 

only the stroke, resulting in a 

hollow shape.

Another side effect to applying a 3D effect to an object with a stroke applied 
pertains to artwork mapping. You already know that artwork mapping 
allows you to apply 2D art to the surface of any 3D object. We’ll discuss 
exactly how artwork mapping is applied later in the chapter (see the section 
“Mapping Artwork to 3D Surfaces”), but one of the main tasks you’ll need to 
do with artwork mapping is choose on which surface of a 3D object you want 
your mapped artwork to appear (you can apply artwork to multiple surfaces, 
as you will learn later).

When you apply an Extrude effect to a rectangle with just a fi ll, the result is 
a 3D object that has six surfaces. However, if you apply a stroke to that rect-
angle, the result is a 3D object with 16 surfaces. This is because Illustrator 
counts all the surfaces generated by the fi ll as well as those generated by the 
stroke (the surfaces that appear along the inside of the stroke, even though 
they are not visible, are still counted as surfaces). Because of this, it can be 
diffi cult to choose from the numerous surfaces to fi gure out which one you 
want the artwork mapped onto.

Of course, sometimes you will want to apply a stroke to an object with a 3D 
effect, such as with extruded text. By adding a stroke to your text object, you 
can create text that is fi lled with one color but that is extruded using a dif-
ferent color (Figure C.11). Chances are you won’t be mapping artwork onto 
your text, so this example is a good use of a stroke on a 3D object.

Figure C.11 When 

extruding text, adding a 

stroke allows you to create 

a powerful contrast to the 

extruded effect.
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In review, feel free to use strokes on your objects if you need them to achieve 
the look you want. However, be aware that adding strokes slows performance 
and makes artwork mapping a confusing process because of all the extra 
surfaces.

Editing a 3D Effect

Because 3D is a live effect in Illustrator, you can make edits to the original 
vector shape on the artboard, and the 3D effect updates accordingly. You can 
also change the color of the object, and the 3D effect automatically updates 
as well, including the shading of the object.

You know that you can click an effect listed in the Appearance panel to edit 
3D effects that have already been applied to artwork. However, it’s important 
to remember that the artwork that appears on your artboard after you’ve 
applied a 3D effect is 2D. If you want to rotate a 3D object, don’t do it on the 
artboard using the usual transformation tools. Rather, click the 3D effect in 
the Appearance panel, and rotate the object in the 3D Options dialog box. 
Changing the artwork on the artboard produces undesirable results 
(Figure C.12). For more information on transforming artwork that has live 
effects applied, see the sidebar “Transforming Objects with Effects” in 
Chapter 7, “Working with Live Effects.”

Figure C.12 What started 

as a water bottle (left) may 

not appear the same when 

you rotate it on the artboard 

(right). To rotate the bottle 

in 3D, you have to edit the 

3D effect.
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Applying the 3D Extrude & Bevel Effect

Now that you generally understand how the 3D effect works in Illustrator, 
you will learn how to apply the effect, determine all its settings, and, per-
haps most importantly, study a few practical examples of how you might use 
such an effect.

As we defi ned earlier, the Extrude & Bevel effect adds depth to an object. To 
apply this effect, select a vector object on the artboard, and choose Effect > 
3D > Extrude & Bevel to open the 3D Extrude & Bevel Options dialog box. 
First, select the Preview check box in the dialog box so you can see what the 
3D effect looks like as you adjust the settings. If you don’t have a large screen, 
it helps to position your artwork on one side of the screen before you apply 
the effect and to move the 3D Extrude & Bevel Options dialog box (when 
it opens) to the other side so you can see the preview on the artboard 
(Figure C.13).

At this point, you are ready to begin experimenting with the settings in the 
dialog box. To make the feature more approachable, Adobe splits the dialog 
box into two parts. By default, only half the settings appear in the dialog 
box. By clicking the More Options button, you can expand the dialog box 
to show all the settings we will be talking about here (Figure C.14).

Figure C.13 Especially 

on smaller screens, it helps

 to keep your art positioned 

on the left side of the screen 

so you have room to 

preview the art while you 

make adjustments in the 

3D Extrude & Bevel Options 

dialog box.
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The 3D Extrude & Bevel Options dialog box is divided into three sections—
Position, Extrude & Bevel, and Surface—each covering a different aspect of 3D.

Specifying the Position settings

The Position section of the 3D Extrude & Bevel Options dialog box lets you 
rotate your object within 3D space (on its X, Y, and Z axes) in order to control 
the view of your object. In 3D applications, the term camera is used to defi ne 
the view of the object (as if you were seeing the object through the lens of a 
camera; Figure C.15).

The most distinctive element in the 3D Extrude & Bevel Options dialog box 
is what Adobe engineers affectionately call the track cube—a visual repre-
sentation of the position of your 3D object. The track cube acts much like a 
trackball, only it isn’t round (and hence it’s called the track cube). To adjust 
the position of your 3D object, simply click and drag the track cube. As you 
adjust the position, a wireframe preview appears on your screen, indicating 
how the object will appear (Figure C.16). When you release the mouse, a full 
preview, with shading, appears.

Figure C.14 By clicking the 

More Options button, you 

can expand the 3D Extrude & 

Bevel Options dialog box to 

see all the available settings.

NOTE You’ll always 

have to select the 

Preview check box when you 

open the dialog box. Adobe 

chose this behavior for 

performance reasons.

NOTE Most 3D 

applications allow you 

to change the position of the 

objects and the camera in a 

scene. Because each 3D effect 

lives within its own 3D world, 

the camera in Illustrator is 

always stationary, and you are 

adjusting the position of the 

object only.
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The track cube is more than just fun to play with—it also has some pretty 
cool functionality. The sides of the cube are shaded in different colors to 
help you easily identify the position of your object: The front side is blue, the 
back is a dark gray, the top and bottom are light gray, and the left and right 
sides are a neutral gray.

Figure C.15 The Position 

setting allows you to rotate 

the view of an object, as if 

you were looking at the 

object through the lens of 

a camera.

Figure C.16 As you adjust 

the track cube, a wireframe 

preview shows you what 

your art will look like.
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In addition, as you move your pointer over the edges of each side, you’ll 
notice the edges highlight in red, green, and blue (Figure C.17). Clicking 
and dragging these highlighted edges constrains the object to rotate along 
only one axis, making it easier to control the position of your object. Holding 
the Shift key while dragging the track cube simulates a rotation of the fl oor 
beneath the object, and dragging the outer ring of the track cube constrains 
the rotation in the other direction.

Along the right side of the track cube are three values representing the three 
axes that a 3D object needs. Each axis can have a value of –180 to 180 degrees 
(for a total of 360). You’ll notice that the highlighted, colored track cube 
edges match the color shown for the icon in each of these three axes.

Appearing directly above the track cube is a pop-up menu that lists preset 
positions from which you can choose. Choosing one of these presets posi-
tions your object in a variety of different views. Unfortunately, you cannot 
defi ne your own presets here, but these presets can make it easy to apply 
consistent views throughout your artwork (Figure C.18).

Last, you can add perspective to your object by dragging the Perspective slider. 
This setting mimics the natural lens distortion that occurs if you move your 
object closer to the lens of the camera (Figure C.19). If you hold the Shift 
key while adjusting the slider, you will see your preview update in real time 
(system performance permitting). Using the Shift key to generate real-time 
previews actually works when using any slider in the 3D dialog box.

Figure C.17 Moving your 

pointer over the edges of 

the track cube allows you to 

adjust one axis at a time.

NOTE Illustrator uses a 

track cube instead of a 

trackball because it is diffi cult 

to differentiate between the 

multiple sides (front, back, and 

so on) of the 3D object using a 

sphere as a reference.
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Figure C.18 Choosing one 

of the preset position set-

tings in Illustrator can make 

it easy to position several 

objects with the same view, 

such as when you are creat-

ing isometric art.

Figure C.19 Adjusting the 

Perspective slider can add 

natural distortion to your 

object.
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You will notice that as you increase the Perspective value, your 3D object 
becomes darker. Think about it: As you move an object closer to the lens of a 
camera, less light is available to refl ect off the object, and the object becomes 
darker. Soon we’ll talk about surface and lighting options, which you can use 
to adjust the lighting of the object.

Specifying the Extrude & Bevel settings

The Extrude & Bevel section of the 3D Extrude & Bevel Options dialog box 
allows you to defi ne the depth of your object as well as how the edges of your 
3D object appear, also known as the bevel.

To adjust the depth of your object, enter a numeric value, click and drag the 
Extrude Depth slider, or enter a value in the fi eld. If you hold the Shift key 
while adjusting the slider, you can preview the Extrude Depth setting 
in real time. The values used for the Extrude Depth settings are shown in 
points, although you can specify values in inches or any other format, and 
Illustrator will do the conversion for you. You can specify an extrude depth 
up to 2,000 points (a tad more than 27.75 inches). Speaking of measure-
ments, when you’re trying to create package mock-ups, it’s always a good 
idea to work at actual size or in scale to ensure that your 3D object is propor-
tioned correctly.

By default, Illustrator creates closed extruded objects from fi lled paths. 
However, you can also specify the extrude setting you want to use so it 
shows only the extrusion and not the actual face or back of the shape. 
Toggling between the two Cap settings lets you control whether your 
objects have a solid or hollow appearance (Figure C.20).

When you extrude an object, you can almost think of copying your object, 
offsetting the copy from the original, and then connecting the two with 

TIP While the 3D 

Extrude & Bevel Options 

dialog box is open, press the 

Option (Alt) key, and the Cancel 

button turns into a Reset but-

ton. Clicking the Reset button 

resets the values in the dialog 

box so you can start fresh.

TIP When you specify a 

bevel, sometimes you 

might see rendering errors 

caused by self-intersecting 

paths. You can usually alleviate 

the problem by specifying a 

smaller bevel size, using a less 

complex bevel, or adjusting the 

position or perspective settings.

Figure C.20 The Cap 

setting appears as two icons. 

The shaded icon indicates the 

selected setting.
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straight lines (Figure C.21). A bevel is defi ned when you connect the two 
shapes with a line that is not straight, and therefore, the extrusion follows 
the direction of the line (Figure C.22).

Figure C.21 A normal 

extrude is created by con-

necting the front and back 

faces of an object with a 

straight line.

Figure C.22 An extrude 

with a bevel is created by 

connecting the front and 

back faces of an object with a 

line that is not straight.

Illustrator provides 10 bevels, which you can choose from the Bevel pop-up 
menu. The Height setting controls the size of the bevel. You can also choose 
whether you want the bevel to be subtracted from the size of the original 
shape or whether you want it added to the shape (Figure C.23).

Figure C.23 Toggling 

between Bevel Extent In and 

Bevel Extent Out options can 

affect the overall size of your 

object.
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Specifying the Surface settings

The fi rst two settings of the 3D Extrude & Bevel Options dialog box, Position 
and Extrude & Bevel, defi ne the actual geometry of the shape. The Surface 
section enables you to control the appearance of the surface of your object. 
This includes the type of shading used, and it indicates how light will inter-
act with the object. If you talk to photographers, they will tell you that, 
above all, lighting is of utmost importance. As you’ll fi nd out, the same is 
true with 3D.

You may have noticed that when you fi rst selected the Preview check box 
to see what your 3D effect looks like on the artboard, the object changed 
somewhat in color. For example, if your original object was fi lled with a 
bright yellow color, the object might now show a darker, muddy yellow color 
instead. By default, 3D objects in Illustrator are rendered with a single light 
source from the upper right and are shaded by adding black to the original 
fi ll color, giving a darker appearance.

Using the Surface pop-up menu, you can choose from one of four options to 
specify the type of surface you want your 3D object to have. The surface type 
you choose also defi nes what other surface settings are available for your 
object and ultimately how you see the fi nal 3D object (Figure C.24).

Figure C.24 From left to 

right, this art demonstrates 

examples of Plastic Shading, 

Diffuse Shading, No Shading, 

and Wireframe.
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The four surface settings are as follows:

• Plastic Shading. You use the Plastic Shading setting when you want your 
object to have a highly refl ective surface, such as glass or metal. This shad-
ing option lets you adjust and control a lighting highlight on the object.

• Diffuse Shading. You use the Diffuse Shading setting when you want 
your object to have a matte surface, such as paper or wood. This shading 
option does not have a highlight setting.

• No Shading. The No Shading option disables shading completely and 
renders each side of your object using the solid color defi ned for the 
object. Granted, this option doesn’t leave your object with a 3D appear-
ance, but if your intent is to expand the 3D effect so that you can edit the 
geometry of the shape, this setting could be helpful.

• Wireframe. The Wireframe surface setting removes all fi lled areas, or 
walls, from your object and displays the object’s 3D wireframes. The 
result is technical and rather cool, and it is useful for creating design 
elements. The rules that make up the wireframe are set to .25 point in 
width and cannot be changed without fi rst expanding the 3D effect.

On the left side of the Surface section of the dialog box is a lighting sphere, 
which is used to control how light is directed at your 3D object. A small white 
circle indicates the light source, and you can drag it to control the direction 
of the light (Figure C.25). As you move the light source, you can hold the 
Shift key to see the shading preview in real time. To add lights (you can add 
up to 30 of them), click the New Light icon that appears directly below the 
sphere, and to delete a selected light, click the Delete Light icon. You can also 
send lights behind an object by clicking the Move Selected Light to Back of 
Object icon.

Figure C.25 You can drag 

lights across the sphere to 

adjust the shading of the 3D 

object.
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To the right of the lighting sphere are fi ve settings that defi ne how the 
surface and the lighting interact with each other. Depending on the surface 
option you select, you may see all or only some of these options:

• Light Intensity. The Light Intensity setting controls the strength, or 
brightness, of the selected light. Think of this setting as a dimmer 
switch—the closer the value is to 100, the brighter the light; the closer 
the value is to 0, the dimmer the light. You can use this setting to 
apply different intensity values for each selected light.

• Ambient Light. The Ambient Light setting is a general lighting setting 
that affects the entire surface of the object. By default, this is set to 50%, 
which is a neutral setting. Think of this setting as a global lightness/
darkness setting for the object itself, not for the individual lights.

• Highlight Intensity. The Highlight Intensity setting controls the con-
trast or transition between the surface and the highlight. Higher values 
produce sharper highlights, indicating a more refl ective surface, like 
glass. This highlight setting is applied globally to all highlights on the 
object (you can’t set this differently for different lights). This setting is 
available only when you choose the Plastic Shading option.

• Highlight Size. The Highlight Size setting controls the size of the 
highlights on a 3D object. This highlight setting is applied globally to 
all highlights on the object (you can’t set this differently for different 
lights). This setting is available only when you choose the Plastic 
Shading option.

• Blend Steps. The Blend Steps setting is an extremely important set-
ting, and therefore, it’s diffi cult to understand why it appears listed at 
the bottom of the dialog box, grouped with other lighting settings and 
seemingly hidden. Illustrator uses blends to create shading, not gradi-
ents (blends are covered in depth in Chapter 2, “Selecting and Editing 
Artwork”). A blend consists of a start object and an end object, with mul-
tiple “steps” in between. If there are too few steps in a blend, you can see 
the individual steps, which results in shading that appears posterized 
and not smooth (Figure C.26). By default, Illustrator specifi es 25 blend 
steps, which is fi ne for viewing art on a computer screen or for print-
ing smaller 3D shapes; however, for the best results in a high-resolution 
print workfl ow, a blend step setting of 200 or more is necessary. The 
reason why the default setting in Illustrator is set to 25 is strictly for 
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performance reasons. A higher Blend Steps setting results in much slower 
3D performance, so it’s a good idea to work with the default setting and 
then increase it right before you send your fi nal fi le to the printer.

Figure C.26 Without 

enough steps in a blend, 

you can see “stair-stepping” 

side effects (referred to as 

banding) rather than a 

smooth transition of color.

Illustrator also offers a pop-up menu from which you can choose a shading 
color. By default, Illustrator adds black to your object to simulate shading; 
however, you can choose Other and pick any color from the Color Picker or 
from existing swatches in your document to use as a shading color instead. 
If you use colors other than black for shading, the result will be as if you 
were casting a colored light on your object.

Using Spot Colors in 3D Objects

If your object is fi lled with a spot color and if you use black or a spot color as 
your shade color, selecting the Preserve Spot Colors option causes the over-
print function to be utilized when you’re creating blends for shading. The 
result is an object that prints and separates correctly using the spot colors. 
You may have to view your fi le with Overprint Preview selected if you want 
to preview the art correctly on your screen.

TIP If you want to use 

gradients to do your 

own shading (which decreases 

fi le size when you’re exporting 

art to Flash), choose the No 

Shading option, expand the 

appearance of the object, and 

then manually fi ll the shapes 

with gradients.



APPENDIX C: EXPLORING THE WORLD OF 3D20

Creating 3D Geometry—Draw Visible Faces

Although it’s true that the 3D feature in Illustrator is doing real 3D render-
ing in a 3D world, that’s true only while a 3D effect dialog box is open on 
your screen. Once you click OK, Illustrator creates a 2D representation of 
that graphic and displays it on your artboard (the artboard is only 2D). If 
you want to view your object differently, you can always edit the effect by 
clicking it in the Appearance panel, at which time the dialog box opens. At 
this point, you’re in the 3D world again, where you can rotate the object in 
space and then click OK to create the 2D representation that is displayed on 
the artboard.

Because Illustrator knows that the end result will be a 2D drawing, it saves 
processing time by calculating and drawing only the visible sides of an 
object. For example, if you were to create a rectangle and extrude it to create 
a cube, at any one time you would be able to view only three of the six sur-
faces. You can see this for yourself by following a few quick steps to expand 
the appearance of a 3D object:

1. Using the Rectangle tool, draw a 2-inch square.

2. Give the square a solid color fi ll of choice and a stroke of None.

3. Choose Effect > 3D > Extrude & Bevel.

4. Leave the position set to Off-Axis Front, set Extrude Depth to 2 inches, 
and click OK to apply the effect.

5. Choose Object > Expand Appearance to expand the 3D effect.

6. Deselect the object so nothing is selected.

7. Switch to the Direct Selection tool, and move each panel of the 
cube. You’ll see that only the visible surfaces of the cube are there 
(Figure C.27).

Figure C.27 A regular 

square (left), with an Extrude 

effect applied (center), and 

then expanded with the front 

face removed (right).
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Creating 3D Geometry—Draw Hidden Faces

Sometimes, however, you might want the full geometry of the 3D object ren-
dered. For example, if you wanted to expand the cube you created to modify 
the 3D object on your own, you might want all the surfaces to be available. 
For this reason, Illustrator includes the Draw Hidden Faces option, which 
forces Illustrator to render the entire object, even the surfaces that aren’t 
visible. Again, you can easily see the difference by following a few short steps 
using the Draw Hidden Faces option:

1. Using the Rectangle tool, draw a 2-inch square.

2. Give the square a solid color fi ll of choice and a stroke of None.

3. Choose Effect > 3D > Extrude & Bevel.

4. Leave Position set to Off-Axis Front, and set Extrude Depth to 2 inches.

5. Click the More Options button in the 3D Extrude & Bevel Options dialog 
box, and select the Draw Hidden Faces check box.

6. Click OK to apply the 3D effect.

7. Choose Object > Expand Appearance to expand the 3D effect.

8. Deselect the object so nothing is selected.

9. Switch to the Direct Selection tool, and move each panel of the cube. 
You’ll see that all the surfaces of the cube are there, even those hidden 
from view (Figure C.28).

As you learn more about the 3D effect, you’ll fi nd the Draw Hidden Faces 
option has other uses as well.

Figure C.28 A regular 

square (left), a regular 

square with an Extrude effect 

applied with Draw Hidden 

Faces selected (center) and 

then expanded, and with the 

front face removed (right).
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Creating a Photorealistic Button

Now that you’ve learned the different settings for the 3D Extrude & Bevel 
effect, it’s time to put that knowledge to good use. In this exercise, you will 
create a realistic button (the kind you would fi nd sewn to a shirt), but don’t 
worry—you don’t need to know how to draw. The Illustrator 3D effect allows 
you to create this button easily by drawing simple shapes.

  1. Using the Ellipse tool, create a .25-inch circle.

  2. Fill the circle with a color of choice, and set the Stroke setting to None.

  3. With the circle selected, double-click the Selection tool in the Tools panel 
to open the Move dialog box.

  4. Specify a Horizontal value of .375 inch and a Vertical value of 0, and click 
the Copy button. This gives you two buttons.

  5. Now, select both circles, and double-click the Selection tool to open 
the Move dialog box again.

  6. This time, specify a Horizontal value of 0 and a Vertical value of 
.375 inch, and click the Copy button. You now have four circles 
(Figure C.29).

 

 7. Select all four circles, and click the Unite button in the Pathfi nder panel. 
This combines the four circles into a single shape.

  8. Using the Ellipse tool, create a 2-inch circle.

  9. Give the large circle the same fi ll as the other small ones and a stroke 
of None.

10. With the large circle selected, choose Object > Arrange > Send to Back.

11. Using the Selection tool, select all fi ve circles, and open the Align panel.

Figure C.29 Once you’ve 

created the duplicates, you 

should see four circles.
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12. Click the Horizontal Align Center button once and the Vertical Align 
Center button once. Because you combined the four smaller circles with 
the Unite function, they are centered nicely within the larger circle 
(Figure C.30).

Figure C.30 All the circles, 

centered, now make up the 

shape of a button.

13. With all fi ve circles still selected, open the Pathfi nder panel, and click 
the Minus Front button. This “cuts” the smaller circles out from the 
larger one, allowing you to see through the button. This action also 
combines all fi ve circles into a single path, allowing you to apply a single 
3D effect to all the circles at once (Figure C.31).

Figure C.31 Once you’ve 

subtracted the smaller circles 

from the larger one, you’re 

left with the art that you will 

use to create a button.



APPENDIX C: EXPLORING THE WORLD OF 3D24

14. With the button artwork selected, choose Effect > 3D > Extrude & Bevel, 
and select the Preview check box.

15. Set Extrude Depth to .25 inches, and set the bevel to Rounded.

16. Adjust the position to your liking, and click OK to apply the effect 
(Figure C.32).

 

Because 3D is applied as a live effect, you can change the color of the button 
simply by applying a different fi ll color to the shape. Additionally, you can 
click the effect in the Appearance panel to edit it and change the position of 
the button so you can view it from virtually any angle (Figure C.33). This is a 
great example of how you can use the 3D Extrude & Bevel effect in a creative 
way, allowing you to easily create design elements that might otherwise be 
diffi cult to draw.

Figure C.32 A wireframe 

preview allows you to posi-

tion your 3D object with 

precision.

Figure C.33 Once you’ve 

created the button in 3D, you 

can change its fi ll color and 

position so you can view it 

from any angle.
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Applying the 3D Revolve Effect

As we briefl y discussed earlier, the Revolve effect adds dimension to an 
object by rotating a 2D shape around an axis. To apply this effect, select a 
vector object on the artboard, and choose Effect > 3D > Revolve to open the 
3D Revolve Options dialog box. First, select the Preview check box in the 
dialog box so you can see what the 3D effect looks like as you adjust the set-
tings. If you don’t have a large screen, it helps to position your artwork on 
one side of the screen before you apply the effect and to position the 3D 
Revolve Options dialog box, when it opens, to the other side so you can see 
the preview on the artboard.

At this point, you are ready to begin experimenting with the different set-
tings in the dialog box. As with the 3D Extrude & Bevel Options dialog 
box, the 3D Revolve Options dialog box has a More Options button, which 
expands the dialog box to reveal all the settings for the feature (Figure C.34).

Figure C.34 Similar to the 

3D Extrude & Bevel Options 

dialog box, you can expand 

the 3D Revolve Options 

dialog box to reveal more 

options.

The fully expanded 3D Revolve Options dialog box is divided into three sec-
tions: Position, Revolve, and Surface. The Position and Surface sections are 
identical to those in the 3D Extrude & Bevel Options dialog box, so we will 
focus on just the Revolve section here.
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Specifying the Revolve Settings

The Revolve section of the 3D Revolve Options dialog box allows you to 
defi ne exactly how your object will appear when revolved around an axis. 
Before we discuss the settings, it’s important you fi rst understand how the 
3D Revolve effect in Illustrator works. By default, the leftmost point of the 
selected object becomes a vertical axis for the effect. An object can have only 
one axis, and the axis is always vertical. Unfortunately, Illustrator doesn’t 
preview or show you this axis onscreen, so think of it as an imaginary axis 
(Figure C.35).

 

Now that you understand how the 3D Revolve effect works, you can learn 
how to use the remaining settings in the Revolve section of the dialog box:

• Angle. The Angle setting determines how far around the axis the artwork 
travels. By default, the angle is set to 360, which creates a shape that goes 
completely around the axis, resulting in a closed shape. Smaller values 
result in an object that seems to have a piece missing (Figure C.36). You 
may fi nd the Angle setting useful when you want to create a cutaway view 
to the inside of an object or when you want to display just a portion of an 
object, like a single slice of pie (Figure C.37).

Figure C.35 By default, 

the 3D Revolve effect in 

Illustrator uses the leftmost 

side of an object as the 

vertical axis.

Figure C.36 Using a large 

Angle setting can leave you 

with almost an entire pie…

Imaginary Axis
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• Cap. Similar to the Cap setting in the 3D Extrude & Bevel Options dialog 
box, here you can toggle between objects that have either a solid appear-
ance or a hollow appearance.

• Offset. The Offset setting is specifi c to the invisible axis. An Offset value 
repositions the axis and effectively allows you to revolve an object from 
a point other than its leftmost edge. The result is an object that is hol-
low (Figure C.38). In addition, you can specify whether the axis is offset 
from the left or right side of the object.

Drawing a sphere

Now that you’ve learned how the 3D Revolve effect works, you can learn how 
to create a simple object—a sphere (Figure C.39).

Figure C.37 …or you can 

be left with just a small slice 

of pie with a small Angle 

setting.

Figure C.38 Adding an 

Offset value to the 3D pie 

results in a pie that resembles 

a Danish pastry with a 

hollow center.

Figure C.39 From left 

to right: creating a circle, 

deleting an anchor point 

to create a semicircle, and 

applying a 3D Revolve effect 

to create a sphere.
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1. Using the Ellipse tool, draw a 2-inch circle.

2. Give the circle a fi ll of choice and a stroke of None.

3. Select the Direct Selection tool, and deselect the circle.

4. Then select just the left anchor point of the circle by clicking it once.

5. Once the anchor point is selected, press the Delete key on your keyboard 
to remove the selected anchor point and the paths connected 
to it. You will be left with half a circle.

6. With the semicircle selected, choose Effect > 3D > Revolve. The default 
settings are fi ne for this exercise.

7. Click OK to apply the effect.

The most important part of this exercise was deleting half the circle. As 
we mentioned earlier, the left side of the object is what defi nes the invisible 
axis on which the object revolves. If you were to apply a 3D Revolve effect to 
a full circle, the result would be quite different (Figure C.40). In fact, apply-
ing the 3D Revolve effect with an offset value specifi ed would produce a 
doughnut shape, which is nice but not what you intended (Figure C.41). 
Getting hungry?

Figure C.40 It’s important 

to pay attention to where 

the vertical axis is. With a 

semicircle (left), the vertical 

axis is positioned to create 

a sphere. With a full circle 

(right), though, the vertical 

axis is positioned to create a 

doughnut shape.

Figure C.41 Starting with 

a full circle (left) and specify-

ing an offset for the axis (cen-

ter) results in a doughnut 

shape (right).
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Drawing an Exercise Barbell

To get your mind off food for a while, here’s a little mental exercise that 
uses the 3D Revolve effect and incorporates the use of groups—an extremely 
important aspect of creating complex 3D shapes (see the sidebar “The 
Importance of Applying 3D Effects to Groups” later in this chapter). In this 
example, you will create a group of shapes that will result in a great-looking 
barbell. Again, you don’t want to focus on drawing a barbell as much as try-
ing to build the shapes that will eventually help the Illustrator 3D feature 
draw it for you (it’s always preferable to let the computer do all the hard work 
while you relax and rack up the billable hours).

To create the barbell, perform the following steps:

1. Choose View > Show Rulers, and drag out a vertical guide (anywhere on 
your screen is fi ne).

Although creating a guide isn’t necessary, you will fi nd that this vertical 
guide will help you visualize where the invisible axis will be. In addi-
tion, the guide will help you align the objects so they are all aligned to 
the same left edge.

Remember when you used ordinary circles to create a button using the 
Extrude effect? Well, this time, you’re going to use ordinary rectangles 
to create your barbell.

2. Use the Rectangle tool to create a rectangle with a width of .25 inches 
and a height of 3.25 inches.

3. Give the rectangle a fi ll of 60K and a stroke of None. This shape will be 
the handle for your barbell.

4. Position the rectangle so that its left edge touches the vertical guide you 
created in the previous step (Figure C.42).

 

Figure C.42 Aligning the 

rectangle to a guide will help 

you visualize where the ver-

tical axis will be.
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  5. Create a second rectangle with a width of 1.25 inches and a height of .25 
inches.

  6. Give the rectangle a fi ll of 25K and a stroke of None. This shape will 
be one of the weights that appear on your barbell.

 7. Choose the Selection tool, and select both rectangles.

  8. Then, click the larger rectangle once, and open the Align panel.

  9. Click the Horizontal Align Left button once and the Vertical Align 
Bottom button once.

10. Then select just the smaller rectangle, and double-click the Selection 
tool in the Tools panel to open the Move dialog box.

11. Specify a value of 0 for Horizontal and .25 inch for Vertical, and click OK 
(Figure C.43).

 

12. Select the small rectangle, and double-click the Selection tool to open 
the Move dialog box.

13. Specify a value of 0 for Horizontal and .375 inch for Vertical, and click 
the Copy button. You will now see two stacked rectangles. These will be 
the weights that appear on one side of the barbell.

14. To create the weights that will appear on the opposite side of the barbell, 
select both small rectangles, and open the Move dialog box once again.

Figure C.43 The fi rst two 

rectangles are in position. 

Notice how they both are 

aligned to where the vertical 

axis will be.
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15. Enter a value of 0 for Horizontal and 2.125 inches for Vertical, and click 
the Copy button. You now have all the shapes necessary to create your 
3D shape (Figure C.44).

 

Figure C.44 All the neces-

sary shapes are now created 

and aligned correctly.

16. Use the Selection tool to select all the objects, and choose Object > 
Group. This will allow the 3D effect to treat all the objects as one unit 
so they all share a single vertical axis.

17. With the group selected, choose Effect > 3D > Revolve, and select the 
Preview check box.

18. Edit the position of the object to your liking using the track cube, and 
then click OK to apply the effect (Figure C.45).

 

Figure C.45 Adding a 

Perspective setting can add a 

touch of realism to your bar-

bell. Try adding more lights 

and increasing the highlight 

intensity and blend steps to 

get a more metallic look.
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The most important part of this exercise is to try to visualize where the 
invisible axis is. When you think of a barbell, you may think of it as you nor-
mally see it—lying on the ground in a horizontal format. Because the Illustra-
tor Revolve effect always uses a vertical axis, you had to think of the barbell 
as standing on its side. Once it’s created, you can use the track cube to rotate 
it into any position or orientation you need.

The examples you’ve tried so far should help fuel your creativity and give 
you the information you need to create complex 3D objects on your own.

The Importance of Applying 3D Effects to Groups

When applying any 3D effect, it’s important to understand its limitations so you can fi gure out how to make 

it do what you want. Previously in this chapter, we stated that the Illustrator 3D effects have two main limita-

tions: 3D objects cannot intersect each other, and each 3D object lives in its own 3D world. Hence, each object 

maintains its own individual vanishing point or invisible axis. Basically, multiple objects in your document can-

not share a single vanishing point, share the same perspective, or revolve around the same axis.

If you were paying attention in Chapter 5, “Organizing Your Artwork,” you remember that effects produce a 

different appearance when applied at the group or layer level instead of at the object level. Because 3D is a 

live effect, the same rules for how groups work apply here as well. If you apply a 3D effect at the group level, 

all objects inside that group can share the same vanishing point or perspective.

In the example of the barbell you just created, you were able to create a single axis that all the objects shared 

by grouping all the objects together before applying the 3D effect. Had you selected the objects in the fi le 

and applied the 3D Revolve effect without fi rst creating a group, the result would be different and not what 

you would expect (Figure C.46).

Figure C.46 If you take the same barbell 

example but skip the step that collects all the 

shapes within a single group, the result is 

quite different.
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Applying the 3D Rotate Effect

The Revolve effect doesn’t add dimension to an object. Rather, the effect 
allows you to position a 2D object in a 3D space. Basically, the 3D Rotate 
effect does the same as the 3D Extrude effect without adding any depth. To 
apply this effect, select a vector object on the artboard, and choose Effect > 
3D Rotate to open the 3D Rotate Options dialog box. The settings for this 3D 
effect are identical to those we’ve already discussed, although take note that 
the 3D Rotate effect is limited to far fewer options (Figure C.47). Most nota-
bly, you can specify only the Diffuse Shading or No Shading option, there 
are no bevels, and there is no support for artwork mapping (which we’ll 
cover next).

The 3D Rotate effect can be useful for applying distortion to artwork, such as 
making artwork look as if it’s mounted on a billboard. It also enables you to 
add perspective to your artwork.

Figure C.47 Although 

there is a More Options 

button in the 3D Rotate 

Options dialog box, you’ll 

fi nd it doesn’t really offer 

that much.



APPENDIX C: EXPLORING THE WORLD OF 3D34

Mapping Artwork to 3D Surfaces

One of the features that really sets the Illustrator 3D effect apart from the 
3D effects in other vector applications is the ability to map 2D artwork onto 
the surface of a 3D object. This method of combining 2D and 3D graphics is 
called artwork mapping.

So that you understand what artwork mapping really is, let’s take a closer 
look at a 3D cube. As we discussed earlier in the chapter, a 3D cube has six 
surfaces. Each of these surfaces is treated as a separate entity, and artwork 
mapping is the process of placing artwork on these surfaces (Figure C.48).

You need to know a few facts before working with artwork mapping:

• Artwork must fi rst be defi ned as a symbol before it can be mapped to a 
3D surface. This is actually pretty cool because as you modify a symbol, 
you will see it automatically update on any 3D surfaces. Refer to 
Chapter 9, “Drawing with Effi ciency,” for detailed information on how 
to create and modify symbols.

• You can’t map (wrap) a single symbol across multiple surfaces of a 3D 
object. If your 3D object has multiple surfaces, you can map symbols 
to each side individually (Figure C.49).

Figure C.48 Starting 

with a normal square, a 3D 

Extrude effect produces a 

cube with six surfaces. When 

2D artwork is placed onto 

these surfaces, the result 

is a 3D object with artwork 

mapping.

Figure C.49 To create 

the appearance of artwork 

that wraps around multiple 

sides of an object, you have 

to create multiple symbols 

and map each section 

separately.
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• When rendering a 3D object, Illustrator uses corner anchor points to 
defi ne a new surface. Smooth anchor points will not defi ne a new surface. 
When drawing your art, carefully specifying where corner or smooth 
anchor points appear on your path gives you greater control over how 
many surfaces are created and where they appear (Figure C.50).

Figure C.50 By using cor-

ner anchor points at certain 

points on the path of this 

profi le of a water bottle, you 

can specify several surface 

areas to which you can 

map art.

• Stroked objects make things more complicated. As you learned earlier in 
the chapter, objects with fi lls and strokes applied result in an object that 
has many more surfaces, which makes it diffi cult to work with. When 
you’re creating a 3D object that will have artwork mapped to it, it’s best 
to avoid using stroked paths.

• Although the 3D effect in Illustrator produces vector results, some-
times the 3D effect has to rasterize mapped artwork. If your mapped 
artwork contains gradients or raster images (such as those placed from 
Photoshop), Illustrator renders them at the resolution that is set in the 
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Document Raster Effects Settings dialog box. Even if your mapped art 
contains a high-resolution Photoshop fi le, Illustrator resamples it to 
match the resolution set in the Document Raster Effects Settings dia-
log box. For best results, make sure the resolution setting in this dialog 
box is high enough for your output needs. Refer to “Massaging Pixels in 
Illustrator” in Chapter 7 for more information about the settings in this 
dialog box.

Specifying Mapped Artwork

To map artwork onto the surface of a 3D object, you must fi rst apply a 3D 
effect to an object. Then, from either the 3D Extrude & Bevel Options dia-
log box or the 3D Revolve Options dialog box, click the Map Art button to 
open the Map Art dialog box (Figure C.51). If the Preview check box in the 
resulting Map Art dialog box isn’t selected, select it so you can see what your 
mapped artwork will look like as you adjust it.

Before you can map art onto your object, you have to choose onto which 
surface of the object you want to place your artwork. At the top of the 
Map Art dialog box, the buttons with arrows allow you to navigate or step 
through each of the surfaces of your object. As you step through each sur-
face, Illustrator displays the selected surface in the center of the Map Art 
dialog box. In addition, Illustrator tries to help you identify the selected 
surface by highlighting it with a red outline on the artboard (Figure C.52). 
Depending on the color of your object, this red outline could be helpful, 
or it could be barely visible.

Figure C.51 The Map Art 

button appears directly 

below the Cancel button in 

the 3D Revolve Options or 

3D Extrude & Bevel Options 

dialog box.
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The surface that appears in the Map Art dialog box is shaped as if it is laid fl at. 
You’ll notice as you step through the different surfaces on your object that 
some show a light gray background whereas others show a dark gray back-
ground. Some surfaces may even show a background that is dark gray only 
in certain areas. This is Illustrator letting you know which surfaces, or which 
parts of a surface, are not visible or are hidden from view (Figure C.53). As 
you would expect, if you choose to use the track cube to view your object 
from a different perspective, the shaded surface areas in the Map Art dialog 
box update accordingly.

Once you’ve chosen the surface you want to map art onto, use the Symbol 
pop-up menu to choose a symbol. The selected symbol appears on the sur-
face area in the Map Art dialog box with a bounding box. You can drag the 
symbol to position it to your liking on the surface, and you can also drag the

Figure C.52 Illustrator 

tries to help you iden-

tify each of the surfaces, 

although the alignment of 

the red outlines isn’t always 

perfect on the artboard.

Figure C.53 This surface, 

which is the section that con-

nects the body and 

neck of the water bottle, has 

both shaded and nonshaded 

sections.

TIP It’s easier if you cre-

ate your symbols at the 

correct size before you map 

them to a surface; this way, you 

won’t have to worry about get-

ting just the right size or posi-

tion in the Map Art dialog box.
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handles to resize it (Figure C.54). As you adjust the position of the symbol, 
you will see the preview update on the actual 3D object on the artboard. 
Alternatively, you can use the Scale to Fit button at the bottom of the Map 
Art dialog box to have Illustrator resize your symbol to fi t to the surface, 
although it does so nonproportionally.

Once you’re happy with the size and position of your symbol on the selected 
surface, use the arrows at the top of the dialog box to navigate to another 
side to map additional symbols, as needed. At any time, you can click the 
Clear button to remove a symbol from a selected surface, or you can click 
the Clear All button to remove symbols from all surfaces at once.

By default, Illustrator calculates shading and lighting only for the actual sur-
face of a 3D object, not artwork that is mapped to a 3D surface. Illustrator does 
this purely for performance reasons. We mentioned earlier that 
Illustrator uses blends to calculate shading, and the process of breaking 
down intricately mapped artwork and shading each element with blends 
takes quite a bit of processing. However, to get a realistic appearance, most 
likely you will want your mapped artwork to be shaded, even if it takes a 
bit longer to do so. Selecting the “Shade Artwork (slower)” check box forces 
Illustrator to shade both the surface of your object and the mapped artwork. 

Figure C.54 You can 

move and rotate a symbol 

so that it appears as you 

need it to on the surface of 

the object.

NOTE A surface can 

contain only one sym-

bol. If you want multiple art 

items to appear on a single 

urface, you have to defi ne a 

single symbol with all the 

elements in it.
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This setting applies to the entire object, and you don’t need to turn it on for 
each individual surface.

The last setting in the Map Art dialog box is the Invisible Geometry check 
box; invisible geometry is a slightly technical phrase. When this option is 
selected, Illustrator hides the actual 3D object on your artboard and displays 
just the mapped artwork. The result is a symbol that appears to fl oat in space. 
A good example of when this setting might be useful is when you want to 
make text appear as if it were wrapped around a sphere (Figure C.55).

When you’re happy with your artwork mapping settings, click OK to accept 
the settings in the Map Art dialog box, and then click OK to close the 3D dia-
log box.

What If…You Add Transparency to 3D?

Throughout this entire book, you’ve seen how transparency is integrated 
into the Illustrator feature set with features such as soft drop shadows and 
opacity masks. You might ask yourself, “What if I added transparency to a 
3D object?” After all, wouldn’t it be cool to make a 3D object that was also 
transparent so that you could see right through to the back of the object?

Have no fear—as if the 3D effect weren’t cool enough, you can also create 
transparent 3D objects—but you’ll have to address two issues in order to get 
transparency and 3D to work together.

Figure C.55 You can map 

artwork around a sphere 

(left), and by using the 

Invisible Geometry option in 

the Map Art dialog box, you 

can hide the sphere leaving 

just the artwork (right).
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Applying Transparency

As you learned earlier in the chapter, before Illustrator applies a 3D effect to 
an object, it breaks the object down into its components (fi lls and strokes). In 
that process, transparency attributes are tossed out, and just the appearance 
remains. For example, if you set an object to 50% opacity, the 3D effect sets the 
object to a 50% tint of that color, but you won’t be able to see through to what’s 
behind the object. The trick is that you have to sneak transparency into the 3D 
effect without letting the effect know about it. You can accomplish this in one 
of two ways:

• If you have a single object that you’re working with, you can target 
just the fi ll of the object in the Appearance panel and then change the 
Opacity value (Figure C.56).

• Alternatively, you can create a group (you can create a group of one 
object, if you’d like). If transparency is applied to any object within a 
group, that transparency makes it through the 3D effect unscathed.

Drawing Hidden Sides

Another useful nugget of information that you learned earlier is that, by 
default, Illustrator renders only the parts of a 3D object that are visible. To 
speed up the rendering process, Illustrator doesn’t bother drawing the sides 
of a 3D object that are hidden from view. Well, this presents a problem if 
you’re creating an object that is transparent and you expect to see through 
the front of the object to the back side. After all, if Illustrator isn’t drawing the 
hidden side of an object, how does Illustrator know what the back side of the 
object looks like? The answer is that you have to force Illustrator to draw the 
hidden sides—you do this by turning on the Draw Hidden Faces option in the 
3D Extrude & Bevel Options or 3D Revolve Options dialog box.

NOTE If your symbol 

contains transparency 

or overprint settings, those will 

not interact with the 3D object 

itself. For example, if a symbol 

uses a blending mode and 

you mapped that symbol to 

a 3D object, you wouldn’t see 

the symbol multiplying with 

the 3D shape, because the 

appearance is limited to the 

symbol itself.

Figure C.56 When you’re 

using the Appearance panel, 

targeting the fi ll allows you 

to apply transparency to 

just the fi ll and not the entire 

object.
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Once you’ve addressed the issues of transparency and hidden sides, you’ll 
end up with a 3D object that is truly transparent (Figure C.57). Adding 
transparency to 3D objects opens new doors to creativity, such as when cre-
ating transparent glass bottles and vases. And don’t forget to throw some 
artwork mapping in there as well. If you map art to a transparent 3D object, 
you’ll be able to see through to the art on the other side. Now you’ve got to 
admit—that’s pretty freakin’ cool, no?

What If…You Blend 3D Objects?

In Illustrator, you can select two objects and choose the Object > Blend > Make 
feature to morph one vector shape into another. This technique, covered 
in Chapter 2, can be useful for a variety of tasks including shading, special 
effects, and object distribution. However, what if you created a blend using 
two 3D objects? Would the 3D effect morph as well, along with the blend?

The answer is, yes, it will! If you apply a 3D effect to an object and then 
duplicate that object (so you have two identical objects), you can create a 
blend between them. Because 3D is a live effect, you can edit the 3D effect of 
one of the objects and change the position so you’re viewing the object from 
a completely different angle. The blend will then update—and generate the 
intermediate steps (Figure C.58).

Figure C.57 This martini 

glass is transparent, allow-

ing you to see what is inside.
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Not impressed? Well, in Chapter 11, “Web Design,” you’ll learn how to use 
blends to create instant Flash animations that you can put on your website. 
That means you can create a box and have it rotate in space.

What If…You Apply a 3D Effect to a Graph?

A graph consists of a group of objects. Since a 3D effect applied at the group 
level results in all the objects in that group sharing the same effect, what 
happens if you apply a 3D Extrude effect to a graph? The answer is that you 
get a powerful way to present numbers in an eye-catching manner (Figure 
C.59). And if you add transparency to a 3D graph—well, you can see where 
that might lead.

At the end of the day, the 3D effect in Illustrator has many creative uses. Now 
that you understand everything there is to know about 3D in Illustrator, the 
only limit is your own imagination.

Figure C.58 By creating 

a blend between spheres 

with mapped artwork, you 

can create the illusion of the 

sphere rotating.

Figure C.59 Adding 

3D effects to just about 

anything, such as graphs, 

for example, can turn 

something ordinary into 

something unique and atten-

tion-grabbing.


